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SHAPESHIFTER 3D HELP: INSTALLATION

The installation procedure is slightly different depending on the version of
Director and platform used, and the location where Director is installed on your
system. Make sure you have administrative rights to create files in the directory
where Director is installed on your system.

INSTALLING THE XTRA ON WINDOWS − Director 8.5 and Director MX

Decompress the installation .zip file. This will unpack the Xtra, documentation
and sample files to a folder named "ShapeShifter3D" on your machine. To install
the Xtra, just copy the files ShapeShifter3D.x32 and ShapeShifter3D.dxr to the
Director 8.5 or Director MX XTRAS folder. If you have previously installed an
older copy of the Xtra make sure to remove or replace it.

These are the final pathnames for the Xtra file after being copied to the default
location of the Xtras folder in each application:

Director 8.5− C:\Program Files\Macromedia\Director 8.5\Xtras

Director MX− C:\Program Files\Macromedia\Director MX\Xtras

No additional configuration is needed. Restart Director for the changes to take
effect. The ShapeShifter3D menu item should appear in the XTRAS menu in
Director.

INSTALLING THE XTRA ON WINDOWS − Director MX 2004

Decompress the installation .zip file. This will unpack the Xtra, documentation
and sample files to a folder named "ShapeShifter3D" on your machine. To install
the Xtra, just copy the files ShapeShifter3D.x32 and ShapeShifter3D.dxr to the
Director MX 2004 XTRAS folder. If your copy of Director MX 2004 is installed
at the default location, the files will be located at:

C:\Program Files\Macromedia\Director MX
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2004\Configuration\Xtras\ShapeShifter3D.x32

C:\Program Files\Macromedia\Director MX
2004\Configuration\Xtras\ShapeShifter3D.dxr

No additional configuration is needed. Restart Director for the changes to take
effect. The ShapeShifter3D menu item should appear in the XTRAS menu in
Director.

INSTALLING THE XTRA ON MAC OS 8 AND 9 − Director 8.5

Decompress the installation .sit file. This will unpack the Xtra, documentation
and sample files to a folder named "ShapeShifter3D" on your machine. To install
the Xtra just copy the files "ShapeShifter3D" from the MacClassic folder to the
Xtras folder of your Director 8.5 installation. The final pathname for the Xtra will
be for example:

Macintosh HD:Applications:Macromedia Director 8.5:Xtras:ShapeShifter3D

Now copy the file "ShapeShifter3D.dxr" from the "ShapeShifter3D" folder to the
same directory:

Macintosh HD:Applications:Macromedia Director 8.5:Xtras:ShapeShifter3D.dxr

No additional configuration is needed. Restart Director for the changes to take
effect. The ShapeShifter3D menu item should appear in the XTRAS menu in
Director.

INSTALLING THE XTRA ON MAC OSX 10 − Director MX

Decompress the installation .sit file. This will unpack the Xtra, documentation
and sample files to a folder named "ShapeShifter3D" on your machine. To install
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the Xtra first copy the file "ShapeShifter3D OSX " from the MacOSX folder to
the Xtras folder of your Director MX installation. The final pathname for the Xtra
will be for example:

Macintosh HD:Applications:Macromedia Director MX:Xtras:ShapeShifter3D
OSX

Now copy the file "ShapeShifter3D.dxr" from the "ShapeShifter3D" folder to the
same directory:

Macintosh HD:Applications:Macromedia Director MX:Xtras:ShapeShifter3D.dxr

No additional configuration is needed. Restart Director for the changes to take
effect. The ShapeShifter3D menu item should appear in the XTRAS menu in
Director.

INSTALLING THE XTRA ON MAC OSX 10 − Director MX 2004

Decompress the installation .sit file. This will unpack the Xtra, documentation
and sample files to a folder named "ShapeShifter3D" on your machine. To install
the Xtra first copy the files "ShapeShifter3D OSX " from the MacOSX folder to
the Xtras folder of your Director MX 2004 installation. The final pathname for
the Xtra will be for example:

Macintosh HD:Applications:Macromedia Director MX
2004:Configuration:Xtras:ShapeShifter3D OSX

Now copy the file "ShapeShifter3D.dxr" from the "ShapeShifter3D" folder to the
same directory:

Macintosh HD:Applications:Macromedia Director MX
2004:Configuration:Xtras:ShapeShifter3D.dxr
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No additional configuration is needed. Restart Director for the changes to take
effect. The ShapeShifter3D menu item should appear in the XTRAS menu in
Director.
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SHAPESHIFTER 3D HELP: SHAPESHIFTER 3D BASICS

ShapeShifter 3D is a low polygon count modeler designed specifically for
Macromedia Director 8.5. It is completely integrated with the Director
environment, and models can be exported as Shockwave 3D (.w3d) files directly
to the internal cast of your Director movie. ShapeShifter 3D models have the
extension .ss3D, and can be saved to disk to be modified at a later time. It is
important to understand that ShapeShifter 3D can not open or edit Shockwave3D
files since w3D files are optimized for streaming and playback, not as a raw
model format. Models can be created by scratch or imported from other 3D
modeling tools. ShapeShifter 3D is optimized for the production of models with
less than 5.000 faces, appropriated for real−time applications. It supports the
definition of surface material properties that are translated to Director 8.5
shaders. It also supports the creation of texture coordinates for a texture image
applied to the diffuse material channel of the object. Finally ShapeShifter 3D
allows the creation of a bones structure that can be linked to your model.

As a low polygon tool ShapeShifter 3D limits the number of vertices and
polygons that can be used. Some of the restrictions are listed below:

Maximum number of vertices: 8192

Maximum number of faces: 16384

Maximum number of groups: 128

Maximum number of materials: 128

Maximum number of joints: 128
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SHAPESHIFTER 3D HELP: CREATING GEOMETRY

Every 3D object in ShapeShifter 3D is created from vertices and faces. Vertices
are created with the CREATE VERTEX tool, and are invisible until they are
arranged into faces. Each face is formed by 3 vertices connected by edges. To
create a face in ShapeShifter 3D select the CREATE FACE tool and click on
three different vertices, one at a time. Faces in ShapeShifter 3D are one−sided:
they are only visible from one direction, and this is determined by the order the
vertices are connected when the face is created. If you connect the vertices
counter−clockwise then the face will be visible in the direction facing you. If the
vertices are connected clockwise the face will be visible from the opposite side.
See the ShowMe movie "Creating Faces" available at the TUTORIALS AND
SAMPLES area of the ShapeShifter 3D webiste for a visual explanation of face
creation in ShapeShifter 3D.

Objects can also be created from standard primitives. ShapeShifter 3D allows
creation of boxes, spheres, cylinders and geosheres using the appropriate tool in
the CREATE menu. To create a primitive just select a tool (CREATE SPHERE
for example) and click on a viewport. Hold the mouse button down and drag to
size your primitive. Primitives are also composed of vertices and faces, and they
are good starting points to be shaped into a different model.

Another powerful way to create geometry is by using the EXTRUDE tool. This
tool works only when you have one or more faces selected. See the tutorial movie
"Creating a simple head" available at the ShapeShifter 3D website for a visual
explanation of model building using primitives and the extrude tool.

Geometry in ShapeShifter 3D is organized into groups. A group is simply a
collection of faces. The controls in the GROUPS Tab can be used to select,
rename, hide and recombine groups. The SELECT GROUP tool can also be used
to quickly select a group in a viewport. One important quality of a group is that
materials are assigned to groups, not individual vertices or faces. So if you want
to assign different materials to the same object you have to split it into two
groups (using the REGROUP SELECTED button available in the GROUPS
Tab). By default in Director 8.5 each group will be visible as a different mesh of
the same model. If you need to manipulate each group separately in Lingo you
can choose to export each group as a separate model in the Save As Shockwave
3D exporter options dialog box.
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SHAPESHIFTER 3D HELP: IMPORTING FILES

ShapeShifter 3D can import files created in other 3D modeling programs and
saved as Wavefront .OBJ or 3Dstudio ASC files. Most files are compatible, but
due to the wide variance between OBJ and ASC files saved by different programs
we can not guarantee compatibility with all objects. If you have a file that does
not translate correctly please submit a problem report using the Support area of
the ShapeShifter 3D site at xtras.tabuleiro.com. Our support staff will make sure
your file is analyzed in order to improve compatibility of our importers. It is our
goal to support files generated by the majority of applications, and we will issue
minor updates to ShapeShifter 3D frequently to guarantee this ability. Below we
have listed some known problems and basic information about each file format:

3Dstudio ASC:

This is a simple format for translation of geometry only. Materials are not
supported.

Known issues: None

Wavefront .OBJ:

This is a very popular format and supported by many programs. Unfortunately
this also means that some .OBJ files are not written correctly, and may not import
in ShapeShifter 3D. Our importer only supports .OBJ files with polygonal
meshes: NURB patches cannot be imported into ShapeShifter 3D. Material
properties and texture coordinates are also supported. Materials are usually
described in a file named .MTL, present with all the texture maps in the same
directory of the .OBJ file. Some converters do not write a separate .MTL file: in
this case materials will not be imported into ShapeShifter 3D.

Known issues: Some exporters do not limit the texture coordinates between −1
and 1. In this case the resulting file will have bad texture coordinates mapping.

If the object appears to be inside out, with holes or with faces missing it is
possible that face orientation is wrong in the exporter (Normals are reversed.)
You can select all faces (or just individual groups) in ShapeShifter 3D and use
the "REVERSE VERTEX" command to correct this issue. The "SMOOTH ALL"
button in the FACES Tab can also be used to correct objects that import with
mangled smoothing groups.

Some exporters produce .OBJ files that have large dimensions. The object will
import but you will not be able to see it in the ShapeShifter 3D viewports. If this
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is the case then use the "SELECT ALL" menu item and use the manual scale
option (SCALE TOOL) to reduce the scale of the object (try scaling to 0.1 in all
dimensions.)
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SHAPESHIFTER 3D HELP: CREATING AND ASSIGNING MATERIALS

A material describes the surface properties of an object. Materials are created in
the MATERIALS Tab of ShapeShifter 3D, using the NEW button. Each material
has different properties that describe its colors and how it reacts to lights.
ShapeShifter 3D materials have the same property names available to Director
8.5 shaders. Please consult Director 8.5 help for more information about each
material property. The properties you can define in ShapeShifter 3D are:

Ambient: Controls how much ambient light is reflected by the material.

Diffuse: The default color of the object. It is blended with a texture if one is
assigned.

Emissive: Adds light to the material independently of scene lighting.

Specular: Controls the color of the highlights. Only effective when the shininess
property is greater than 0.

Shininess: Controls the percentage of the surface devoted to highlight. A value of
0 disables specular highlights. Low values (greater than zero) produce large
highlight areas, while higher values reduce the highlight. Due to differences in
OpenGL the preview of shininess values in ShapeShifter 3D does not match
Director 8.5 in all cases, but the numerical value of shininess is exported
correctly.

Blend: Controls the transparency level of the object.

Texture: The name of an external image file to be used as a texture for this
material. Textures are applied according to the texture coordinates of each group
(see the Editing Texture Coordinates section of the docs for more information on
this.)

Once a material is defined it can be assigned to a geometry group. This is done in
the GROUPS Tab. Select a group from the groups list. Click the ASSIGN
MATERIAL button. A list with all available materials will appear. Select a
material name and click OK. The 3D view will show the selected group with the
updated material applied.

Important Tip: Almost all 3D accelerator cards requires textures with dimensions
that are a power of 2 (16, 32, 64, 128, 256, 512.) If you use textures that do not
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have these dimensions they will most likely be scaled by Director 8.5 at runtime
to fit these dimensions, thus creating undesirable artifacts. ShapeShifter 3D will
scale your textures for preview to a power of 2, but it will not force scaling of
textures when exporting to Shockwave 3D. We recommend that you always use
dimensions that are square and are a power of 2 (256X256 pixels for example) if
you want to get the best possible image quality for your textures. Also, wherever
possible use smaller images (128X128, 64X64) over that of larger ones
(256X256, 512X512) to increase performance in Director.
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SHAPESHIFTER 3D HELP: EDITING TEXTURE COORDINATES

Each vertex in a ShapeShifter 3D group can be assigned a set of texture
coordinates. These are also known as UV coordinates, and determine the position
of the vertex in a texture map applied to the geometry. Texture coordinates
usually fall in the range of 0 to 1, and this is translated to a relative position of the
vertex in the texture. For example: a vertex with UV coordinates (0,0) will
correspond to the top left corner of a texture map, while a vertex with coordinates
(0.5 , 0.5) will fall in the middle of the map.

To edit texture coordinates a material needs to be created and assigned to a group.
The ShowMe movie "Texturing a dice", available at the TUTORIALS AND
SAMPLES area of the ShapeShifter 3D website shows the process in detail, you
may want to consult it while you read this section.

With a group selected click the "TEXTURE COORDINATE EDITOR" button in
the GROUPS Tab. The texture coordinate window will appear and the texture
will be displayed with any current mapping coordinates for the selected vertices
and faces. In ShapeShifter 3D you can interactively edit texture coordinates and
the results can be viewed in real−time in the 3D perspective window. Select the
faces you want to edit in the FRONT viewport. You can also change the current
viewport projection by clicking in the little arrow to the left of the viewport name
if you want to select faces using a different viewport. When you select a face that
belongs to the group being edited in the Texture coordinate window, the face will
be drawn over the texture in its current coordinates. You can select individual
vertices to be adjusted using the Texture Coordinate SELECT tool. Vertices can
be moved, rotated or scaled using the appropriate Texture Coordinate editing
tools.

ShapeShifter 3D can also project selected faces into the texture to make it easier
to adjust coordinates at beginning, using the REMAP function. To use this
function select a number of faces in the FRONT viewport. Now click the
REMAP Tab in the Texture Coordinate Editor window. Click and drag to mark a
rectangular area covering a portion of your texture: the selected faces will be
remapped to this area. Click CONTINUE. Now select a projection to be used by
the remap function: generally you want to use the same projection used for the
selection. Click REMAP and the selected faces will be projected into the remap
rectangle. This is a quick way to set initial texture coordinates for complicated
models, and you can fine tune the position of the vertices using the other Texture
Coordinate Editor tools after this is done. Again, consult the ShowMe movie
"Texturing a dice" for a visual explanation of Texture coordinate editing in
ShapeShifter 3D.
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SHAPESHIFTER 3D HELP: WORKING WITH JOINTS

Joints are used to define a skeleton structure consisted of bones that is used to
animate a model at runtime. ShapeShifter 3D allows the creation of skeletons and
assignment of vertices to each joint. To create a joint select the CREATE JOINT
tool in the CREATE Palette, and click on a Viewport. If you create a joint while
other joint is selected the new one becomes a child of the parent joint: it will
move and rotate automatically when the parent is moved. Joints can be selected,
renamed and deleted in the JOINTS Tab.

In order for joints to operate and deform geometry you need to assign vertices to
a particular joint in the skeleton. In ShapeShifter 3D this is done in an easy way:
simply select a group of faces or vertices in any viewport window. Click on a
joint name in the joints list, and click the ASSIGN button. You can also select a
joint and click the SELECT ASSIGNED button to check which vertices are
assigned to a particular joint. It is possible to clear joint assignment for a group of
selected vertices by using the UNASSIGN button. And you can use the SELECT
ALL UNASSIGNED button at any time to select vertices that are currently not
assigned to any joint. For a smooth deformation of your model it is a good idea to
have all vertices assigned to a joint.

The current version of ShapeShifter 3D exports bones data to Shockwave3D, and
can optionally export a list of bone names to the USERDATA property of the
model. Bones export is only possible if you choose to export all groups as a
single model, which is the default option for the Shockwave 3D exporter. If you
choose to export each group as a separate model ShapeShifter 3D will not export
the skeleton structure. This restriction exists because the bonesplayer modifier is
applied only to a single model in Director, and can not influence vertices that
belong to different models.

It is possible to use the bones player modifier in Director 8.5 to animate joints
using Lingo. When a bone is moved it will also moves the vertices assigned to it.
The rest of the model's geometry will deform smoothly to accommodate the
change. Please consult Director's documentation for more information on this
topic.

You can also visit the TUTORIALS AND SAMPLES page on our web site to
download sample director movies and models. There you will find a tutorial
available in Quicktime and AVI format that shows the process of creating bones,
and a Shockwave movie that shows how to manipulate bones via Lingo for
interactive animation. Source code is provided for educational purposes.
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SHAPESHIFTER 3D HELP: COMMAND REFERENCE

TITLE BAR

MENU BAR

TOOL
PALETTE

CREATE
PALETTE

VERTEX
TAB

FACE TAB

GROUPS
TAB

MATERIALS
TAB

JOINTS TAB

VIEWPORTS

This is what you see when you launch ShapeShifter 3D:
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FEEDBACK
AREA
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SHAPESHIFTER 3D HELP: COMMAND REFERENCE

TITLE BAR

Double click the title bar or click the minimize button  to minimize/maximize
the ShapeShifter 3D application. Click the close button  to quit the application.
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SHAPESHIFTER 3D HELP: COMMAND REFERENCE

MENU BAR

The menu bar gives you access to many of the features of ShapeShifter 3D. It is located at the top
of the ShapeShifter 3D window. The commands are identified in the Feedback Area as your
cursor passes over each one.

FILE TAB

The File Tab is used for managing documents.

New: Erase the current model and open a new one.

Open: Open an existing ShapeShifter 3D (extension .ss3d) file.

Merge: Load a ShapeShifter 3D file and merge it with the current model.

Save: Lets you save the current model as a ShapeShifter 3D file. If the current model has never
been saved, the Save dialog box appears.

Save As: Save the current model as a ShapeShifter 3D file. The Save dialog box appears where
you can enter the filename and select where you want to save your file.

Import: Import a 3D object of a specific file format. Supported file formats are Wavefront OBJ
and 3D Studio ASC.

Export: Export the current model as a specific file format. Supported file formats are Wavefront
OBJ and 3D Studio ASC.

Save as Macromedia Shockwave 3D: Save the current model as a Shockwave 3D (extension
.w3d) file. A dialog box appears where you can specify a number of options.
Texture Quality: Control the amount of JPEG compression applied to the Textures. Geometry
Precision: Increase or decrease the precision of the current model geometry to reduce file size.
Include Default Light: Check to export a default light. Import W3D to Internal Cast: Check to
automatically export the current model to the internal cast of your Director movie. Overwrite
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existing cast member: Check to automatically replace a previously exported cast member of your
Director movie.

EDIT TAB

The Edit Tab is used for basic operations.

Undo: Undo the last operation.

Redo: Clicking Redo lets you redo what was undone.

Delete Selected: Delete selected objects.

Delete All: Delete all objects.

Duplicate Selection : Duplicate selected faces to a new group.

SELECT TAB

The Select Tab commands let you control selections and the visibility of objects.

Select All: Select all objects.

Select None: Deselect all objects.

Select Invert: Invert the current selection.

Hide Selection: Hide selected objects.
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Unhide All: Unhide all hidden objects.

VIEWPORTS TAB

The Viewports Tab lets you change the configuration of the Viewports displayed on the screen
from a list of predefined arrangements. Click on any of the icons to change to that configuration.

HELP TAB

Register: Lets you register your copy of ShapeShifter 3D. A dialog box appears where you need
to enter the username and Serial number for the software.

About: Open a dialog box showing the current version of ShapeShifter 3D, copyright notices and
URLs for sales and technical support.

Check for Updates: Click to check if a new version of ShapeShifter 3D is available.
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SHAPESHIFTER 3D HELP: COMMAND REFERENCE

TOOL PALETTE

The Tool Palette is located at the top left corner of the screen below
the menu bar. The buttons are identified in the Feedback Area as your
cursor passes over each one. Tools are selected by clicking, and they
stay selected until you choose another tool. Some tools have specific
properties associated with it and they appear at the bottom of the Tool
Palette when you click on a tool. Your cursor will change in
appearance as you select different tools, helping you keep track of
which tool is selected. You can also access each tool by its keyboard

shortcut.

SELECT TOOLS

The Select Tools are located at the top of the Tool Palette. They let you select
objects from different selection modes.

Select Vertex:

Click on a vertex to select it or click and drag around a region to select the
vertexes in that region. Hold down the Shift key while clicking to select more
vertices. Hold down the Control key while clicking to deselect vertices. To
deselect all vertices, click anywhere in the Viewport away from any object.

Shortcut: X

Select Vertex Properties:

Ignore Backfaces: Check to select only the first layer of vertices in the Viewport.
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Select Face:

Click on a face to select it or click and drag around a region to select the faces in
that region. Hold down the Shift key while clicking to select more faces. Hold
down the Control key while clicking to deselect faces. To deselect all faces, click
anywhere in the Viewport away from any object.

Shortcut: F

Select Face Properties:

By vertex: check to select all faces shared by the selected vertices. Ignore
Backfaces: check to select only the first layer of faces in the Viewport.

Select Group:

Click on a group to select it or click and drag around a region to select the groups
in that region. Hold down the Shift key while clicking to select more groups.
Hold down the Control key while clicking to deselect groups. To deselect all
groups, click anywhere in the Viewport away from any object.

Shortcut: G

Select Joint:

Click on a joint to select it or click and drag around a region to select the joints in
that region. Hold down the Shift key while clicking to select more joints. Hold
down the Control key while clicking to deselect joints. To deselect all joints,
click anywhere in the Viewport away from any object.

Shortcut: J
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MANIPULATION TOOLS

The Manipulation tools are located at the bottom of the tool palette. Use these
tools to manipulate objects in the Viewports. Note that when you manipulate an
object in a Viewport you will be operating on that Viewport's 2 axis. The
Viewport axis are identified by 2 colored lines usually displayed at the center of
the Viewport. When you use the manipulation tools the Feedback Area displays
the cursor's position using x, y and z coordinates. You can use the Feedback Area
to see which axis you are operating on.

The Move tool moves selected objects in the Viewports. You can move an
object in two ways: Click−and−drag on a Viewport to move a selected object

or use the Move properties to perform a numeric move.

Shortcut: V

Move Properties:

Enter a value for each axis and click the move button to perform a numeric move.
Click on an axis button (X, Y or Z) to lock the operation on that axis.

The Rotate tool rotates selected objects in the Viewports. You can rotate an
object in two ways: Click−and−drag on a Viewport to rotate a selected object

or use the Rotate properties to perform a numeric rotation.

Shortcut: R
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Rotate Properties:

Use these radio buttons to specify how your object will rotate. Center of mass:
lets you rotate the selection around its center of mass. Origin lets you rotate the
selection around the world origin. User point lets you rotate the selection around
a point you click on the Viewport. To perform a numeric rotation enter a value
for each axis and click the rotate button. Click on an axis button (X, Y or Z) to
lock the operation on that axis.

The Scale tool is used to resize selected objects in the Viewports. Scaling an
object allows you to enlarge or reduce it. You can scale an object in two

ways: Click−and−drag on a Viewport to scale a selected object in the direction
the cursor is dragged. Or use the Scale properties to perform a numeric scale.

Shortcut: S

Scale Properties:

You can select 3 different ways of scaling an object. Center of mass: lets you
scale the selection relative to its center of mass. Origin lets you scale a selection
relative to the world origin. User point lets you scale the selection relative to a
point you click on the Viewport. To perform a numeric scale enter a value for
each axis and click the scale button. Click on an axis button (X, Y or Z) to lock
the operation on that axis.
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The Info tool is used to show the current model statistics, such as number of
vertices, faces, groups, materials and joints, helping you keep track of the

size of your models.
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SHAPESHIFTER 3D HELP: COMMAND REFERENCE

CREATE PALETTE

The Create Palette is located at the bottom left corner below the Tools
Palette. The buttons are identified in the Feedback Area as your cursor
passes over each one. Creation tools are selected by clicking, and they
stay selected until you choose another tool. Some tools have specific
properties associated with it and they appear at the bottom of the
Create Palette when you click on a tool. Your cursor will change in
appearance as you select different tools, helping you keep track of
which tool is selected.

Create Vertex:

Click on a Viewport to create a vertex.

Create Face:

Click on 3 vertices, one at a time, to create a one−sided face.

Create Sphere:

Click and drag on a Viewport to create a sphere and determine its size as you
drag.

Sphere Properties:

Stacks: Click to specify the number of stacks of a new sphere. The Minimum
value is 3 and the maximum is 16 stacks. Slices: Click to specify the number of
slices of a new sphere. The Minimum value is 3 and the maximum is 16 slices.
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Create Geosphere:

Click and drag on a Viewport to create a Geosphere and determine its size as you
drag.

Geosphere Properties:

Depth: Click to specify the depth of a new goesphere. The Minimum value is 1
and the maximum is 3.

Create Box:

Click and drag on a Viewport to create a box and determine its size as you drag.

Create Cylinder:

Click and drag on a Viewport to create a cylinder and determine its size as you
drag.

Cylinder Properties:

Stacks: Click to specify the number of stacks of a new cylinder. The Minimum
value is 3 and the maximum is 16 stacks. Slices: Click to specify the number of
slices of a new cylinder. The Minimum value is 3 and the maximum is 16 slices.
Close Cylinder: Check to create a closed cylinder.

Create Joint:

Click on a Viewport to create a new joint. To create a child joint, select the
intended parent joint first and then click anywhere on a Viewport to create the
child joint.

Extrude:
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The extrude tool only works when you have more than one face selected. You
can use the extrude tool in 2 different ways. First select a number of faces. Then
click and drag on a Viewport to extrude the selection or use the Extrude
Properties to perform a numeric extrusion.

Extrude Properties:

Enter a value for each axis and click the extrude button to perform a numeric
extrusion. Click on an axis button (X, Y or Z) to lock the operation on that axis.
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SHAPESHIFTER 3D HELP: COMMAND REFERENCE

VERTEX TAB

The Vertex Tab gives you access to all the operations you can perform with the
vertices of your current model.

Snap Together: Select 2 vertices and click this button to snap the vertices
together.

Snap To Grid: Lets you snap selected vertices to the lowest grid setting.

Weld Together: Select 2 vertices that have been snapped together and click this
button to combine them into a single vertex.

Remove All Unused: Removes all vertices not assigned to a face in the model.

Flatten: Flatten selected vertices in the x, y or z axis. Click an axis button to
flatten the selected vertices in that axis.
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Mirror: Mirror selected vertices.
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SHAPESHIFTER 3D HELP: COMMAND REFERENCE

FACE TAB

The Face Tab gives you access to all the operations you can perform with the
faces of your current model.

Subdivide: Select faces in the Viewports and click the button 3 to subdivide them
in 3, or the button 4 to subdivide them in 4.

Reverse Vertex Order: Reverse the order of vertex data in a selected face or
faces. This function inverts the face normal of a face, making it appear visible to
the opposite side.

Turn Edge: Select 2 adjacent faces and click this button to turn the edge
connection between the faces.

Face to Front: Change the order of vertex data in a selected face so that the face
normal points to the front.

Smooth All: Smooth all selected faces.
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SHAPESHIFTER 3D HELP: COMMAND REFERENCE

GROUPS TAB

The Groups Tab gives you access to all the operations you can perform with the
groups of your current model. The Groups Tab buttons may be active or dimmed.
If the button's function is not available, the button is dimmed. To activate the
buttons you must first select a group from the Group list.

Delete: Delete a selected group.

Rename: Rename a selected group. A dialog box will appear where you can enter
the new name of that group.

Group List: Gives you a list of all the groups in your current model, along with
the materials assigned to each group.

Hide: Hides the selected group.
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Unhide: Unhide the selected hidden group.

Regroup Selection: Combine all selected objects in a new group.

Assign Material: Lets you assign a material to a group. First select a group in the
group list, and then click the Assign Material button. Choose a material from the
list of materials (shown below) that appeats at the bottom fo the Groups Tab and
click the OK button.

Texture Coordinate Editor
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SHAPESHIFTER 3D HELP: COMMAND REFERENCE

GROUPS TAB: TEXTURE COORDINATE EDITOR

The Texture Coordinate
Editor lets you edit the
texture coordinates of a
selected group. You
must have a material
assigned to a group to
edit its coordinates.
When you click the
Texture Coordinate
Editor button, a window
(left) appears at the left
of the Groups Tab.

Texture Coordinate View: Displays the current texture and geometry.

Field: Displays the name of the current group and material being
edited.

Clamp: Check to restrict the vertex position to the texture size.
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The Edit Tab contains the
tools you can use to view
and manipulate the

texture. The Arrow tool is used to select the geometry to be edited.
Click and drag to select. The Move tool is used to move the selected
geometry. Click and drag to move. The Rotate tool is used to rotate the
selected geometry. Click and drag to rotate. The Scale tool is used to
scale the selected geometry. Click and drag to scale. The Hand tool
locks the view in pan mode. Only the view moves, not the objects
themselves.To pan click anywhere on the window and drag in any
direction. The Zoom in tool magnifies the view and the Zoom out tool
reduces the view. Click to zoom in or out. The Reset View tool resets
the texture coordinate editor view to its original default configuration.

The Remap Tab lets
you remap the selected
geometry texture in
the specific region of
the texture. First click
and drag around a
region in the view to
select it. Then click
the Continue button.
Then Select a
projection from the list
and click the Remap
button.
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SHAPESHIFTER 3D HELP: COMMAND REFERENCE

MATERIALS TAB

The Materials Tab gives you access to all the operations you can perform with
the materials of your current model. The Materials Tab buttons may be active or
dimmed. If the button's function is not available, the button is dimmed. To
activate the buttons you must first select a material from the Material list.

New: Create a new material.

Delete: Delete a selected material.

Rename: Rename a selected material. A dialog box will appear where you can
enter the new name of that material.

Material List: Gives you a list of all the materials in your current model.
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The Material Properties are available when you select a material from the
Material list. They contain a window displaying the appearance of the current
material, buttons and fields to control its properties, and a place where you can
assign a texture to the diffuse channel of the selected material.

Shininess: Lets you change the current value of the shininess property of the
selected material.

Blend: Lets you change the current value of the blend property of the selected
material.

Texture: Choose a texture to be assigned to the diffuse channel of the selected
material. Click the Choose button to select a texture, click the none button to
clear the assignment. You must first assign a texture to a material to edit its
coordinates in the Texture Coordinate Editor available in the Groups Menu.

Ambient: Edit the ambient properties of the selected material. Click the button to
access the ambient properties (left). The bottom part of the materials tab will
change, displaying the ambient color properties. You can select a color specifying
its Red, Green and Blue values by clicking the up and down arrows next to the
values field, or you can choose a color from the color picker. The two boxes
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below the color picker display the previous and current colors for that material,
letting you compare the changes you've made. Click OK to accept the changes or
Cancel to cancel them. Important: you must click the OK button before clicking
anywhere outside the ambient material properties for your changes to take effect.

Diffuse: Edit the diffuse properties of the selected material. Click the button to
access the diffuse properties (left). The bottom part of the materials tab will
change, displaying the diffuse color properties. You can select a color specifying
its Red, Green and Blue values by clicking the up and down arrows next to the
values field, or you can choose a color from the color picker. The two boxes
below the color picker display the previous and current colors for that material,
letting you compare the changes you've made. Click OK to accept the changes or
Cancel to cancel them. Important: you must click the OK button before clicking
anywhere outside the diffuse material properties for your changes to take effect.

Specular: Edit the specular properties of the selected material. Click the button to
access the specular properties (left). The bottom part of the materials tab will
change, displaying the specular color properties. You can select a color
specifying its Red, Green and Blue values by clicking the up and down arrows
next to the values field, or you can choose a color from the color picker. The two
boxes below the color picker display the previous and current colors for that
material, letting you compare the changes you've made. Click OK to accept the
changes or Cancel to cancel them. Important: you must click the OK button
before clicking anywhere outside the specular material properties for your
changes to take effect.
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Emissive: Edit the emissive properties of the selected material. Click the button
to access the emissive properties (left). The bottom part of the materials tab will
change, displaying the emissive color properties. You can select a color
specifying its Red, Green and Blue values by clicking the up and down arrows
next to the values field, or you can choose a color from the color picker. The two
boxes below the color picker display the previous and current colors for that
material, letting you compare the changes you've made. Click OK to accept the
changes or Cancel to cancel them. Important: you must click the OK button
before clicking anywhere outside the emissive material properties for your
changes to take effect.
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SHAPESHIFTER 3D HELP: COMMAND REFERENCE

JOINTS TAB

The Joints Tab gives you access to all the operations you can perform with the
joints of your current model. The Joints Tab buttons may be active or dimmed. If
the button's function is not available, the button is dimmed. To activate the
buttons you must first select a group from the Joint list.

Delete: Delete a selected joint.

Rename: Rename a selected joint. A dialog box will appear where you can enter
the new name of that joint.

Group List: Gives you a list of all the joints in your current model.

Select Assigned : Lets you select all vertices assigned to the selected joint. Select
a joint in the Joint list and click the Select assigned button.
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Assign: Assign selected vertices to the selected joint. First select the vertices you
want to assign to a joint using the selection tools in the Tools palette. Then select
a joint in the Joint List and click the Assign button.

Select All Unassigned: Select all vertices not assigned to any joint.

Unassign: Clear any joint assignment from currently selected vertices.

Show Skeleton: Check or uncheck to show or hide the joints of your current
model.
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SHAPESHIFTER 3D HELP: COMMAND REFERENCE

VIEWPORTS

The Viewports are located at the
center of the screen and they are
where you view, create and
manipulate your models in
ShapeShifter 3D. Each Viewport
displays the current model in a
particular projection. The
projections are: 3D, Front, Back,
Left, Right, Top and Bottom. The
default view of a Viewport
displays its grid and its axis.
Colored lines at the center of the
Viewport identify the axes of a

Viewport. Each color represents a different axis: a yellow line represents the X
axis, a cyan line represents the Y axis and a magenta line represents the Z axis.
All Viewports, except the 3D Viewport, have 2 axes, and any operation
performed in these Viewports take place in those 2 axes. The default setting for
all Viewports, except the 3D Viewport, is to render the current model in
wireframe mode. All settings can be modified in the Viewport Settings (see
below).

3D Viewport : The 3D Viewport is
different from the other Viewports.
It displays the current model in a 3
dimensional environment and let
you rotate around the 3 axes to
view the model from different
angles. Click and drag on the 3D
Viewport to rotate the view around
the 3 axes. Differently from the
other Viewports, you cannot
perform any operation by clicking
on the 3D Viewport other than
rotate the view. The default setting

for this Viewport is to render the current model in textured mode.
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VIEWPORT SETTINGS

The arrow located at the top left corner of every Viewport is used to expand or
collapse the Viewport Settings, where you can switch between different
projections, render modes and show or hide that Viewport axis and grid. Click on
the arrow to open the Viewport Settings. Click on the open arrow to close it.
Projection: The current projection being displayed on that Viewport is identified
by a checkmark. Click on a different projection to change to that projection.
Render mode: The current render mode being displayed on that Viewport is
identified by a checkmark. Click on a different render mode to change to that
mode. Show: check to display the Viewport axis and grid. Uncheck to hide them.

Viewport Label:

Shows the current projection being displayed on that Viewport.

VIEWPORT TOOLS

Each Viewport has its own set of tolls, located at the top of the Viewport
window. The Viewport tools allow you to control how your model appears in the
Viewport. These tools do not affect the objects in any way; they only change how
the objects are viewed.

Pan:

The Pan tool locks the Viewport in pan mode. Only the view moves, not the
objects themselves. To pan click anywhere on the Viewport and drag in any
direction. You can also activate the Pan tool temporarily by holding the spacebar
and clicking on a viewport.
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Zoom:

The Zoom locks the Viewport in zoom mode. It is used to magnify or reduce the
view in a Viewport. Position the cursor in the Viewport and click and drag to
zoom in or zoom out. You can also activate the Zoom tool temporarily by holding
the OPT key (ALT on Windows) and clicking on a viewport.

Reset View:

The Reset view tool resets the current Viewport to its original default
configuration.

Frame Selected Objects:

The Frame Selected Objects tool lets you fit the selected objects in your model
inside that Viewport.

Frame All Objects:

The Frame All Objects tool lets you fit all the objects in your model inside that
Viewport.
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SHAPESHIFTER 3D HELP: COMMAND REFERENCE

FEEDBACK AREA

The Feedback Area is located at the bottom of the ShapeShifter 3D
window. The Feedback Area helps you identify tools and buttons.
As you move the cursor across the tools and buttons in
ShapeShifter 3D, the name and the description of the tool or button
appear in the Feedback area. If you move the cursor over the
Viewports, the feedback area will display the cursor's position,
using the x, y and z coordinates.
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SHAPESHIFTER 3D HELP: HOW TO ORDER AND REGISTER

The unregistered version of ShapeShifter 3D may be used for evaluation,
nonprofit and educational purposes. Check the limitations of the unregistered
version. The registered version of ShapeShifter 3D can be purchased online at
http://xtras.tabuleiro.com using a secure server. At our web site you can also
consult our purchase policy, purchase instructions, payment, delivery and
security methods.

If you decide to buy the Xtra you don't need to download a new copy of the
software. After your order is processed you will receive an e−mail with a serial
number to register the software you've already installed on your machine.

To register go the Help Tab in the menu bar and select the REGISTER button.
Please keep your serial number archived. You will need it to register again if you
re−install Director or the ShapeShifter 3D.
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SHAPESHIFTER 3D HELP:
LIMITATIONS OF THE
UNREGISTERED VERSION

The unregistered version of ShapeShifter
3D is fully functional, but can not save or
export models with more than 500 faces.
This limitation is removed when you
purchase and register the Xtra (using the
HELP−>REGISTER item in the
ShapeShifter 3D menu bar.)
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SHAPESHIFTER 3D HELP: TUTORIALS AND SAMPLES

Please visit the Tutorials and Samples page on our web site to download sample
director movies and models. There you will find tutorials available in Quicktime
and AVI format that shows the process of creating vertices and faces, assigning
texture coordinates, creating bones and more. The web site also contains Director
and Shockwave movies that show how to manipulate bones and models via Lingo
for interactive animation. Source code is provided for educational purposes.
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SHAPESHIFTER 3D HELP: TECHNICAL SUPPORT

Please use the Your Account section available at our web site xtras.tabuleiro.com
to submit your questions. The site also contains Technotes and other resources
that can help you identify and solve the most common problems quickly.
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